CONTENTS

Introduction iii

Don’t get trapped in college debt! iii

This is YOUR PLAN to eliminate college debt – and take the first step to securing lifelong financial success! iv

How to Use the Student Budget Tool v

STEP 1: SET YOUR GOALS 1

Set SMART goals now to enjoy your dream lifestyle later 2

Lifestyle goals 3

Career goals 4

College goals 5

TAKE ACTION! SET YOUR GOALS 5

STEP 2: KNOW YOUR EXPENSES 6

Understanding cash flow 7

Determine your expenses 7

Common college expenses 7

School 7

Housing 13

TAKE ACTION! COMPARE HOUSING OPTIONS 16

Transportation 17

Budget Busters 18

Other expenses 22

TAKE ACTION! LEARN TO LIVE LEAN 24

Cash flow 24

TAKE ACTION! LIST YOUR EXPENSES 24

STEP 3: GET MONEY 25

Traditional Financial Aid 25

FAFSA 25

CSS Profile 25

Grants 25

TAKE ACTION! APPLY FOR FINANCIAL AID 25

Scholarships 26
TAKE ACTION! APPLY FOR SCHOLARSHIPS ........................................... 27
Other Financial Aid .............................................................................. 28
College credits for work experience .................................................. 28
EARN INCOME ..................................................................................... 29
Work-study programs ......................................................................... 30
TAKE ACTION! APPLY FOR WORK-STUDY PROGRAMS ...................... 30
GET A JOB ............................................................................................. 31
Summer can be your biggest earning season ..................................... 32
TAKE ACTION! APPLY FOR JOBS ......................................................... 32
TAKE ACTION! TALLY YOUR INCOME .................................................. 32
Using the Student Budget Tool ............................................................. 32
TAKE ACTION! REVIEW YOUR PLAN .................................................... 32
Making a commitment and getting help ............................................. 33
College Prep Strategies ....................................................................... 36
Get good grades .................................................................................. 36
Take classes that offer college credit .................................................. 36
Take summer and online courses ....................................................... 36
Volunteer and network ...................................................................... 37
Start saving now .................................................................................. 37
Resources ............................................................................................. 38
College Finance Assistance Experts ...................................................... 38
Financial Aid Research (scholarships, grants, work-study) ................. 38
Student discounts .............................................................................. 38
Companies that offer work-study and/or tuition assistance programs ...... 38
Cool Summer Job Search Resources .................................................... 39
Helpful Apps ....................................................................................... 39
INTRODUCTION

DON’T GET TRAPPED IN COLLEGE DEBT!

Earning your college degree should lead to financial gains, yet skyrocketing costs threaten to derail your finances long before you ever cash your first paycheck.

Did you know?

The average student graduates more than $35,000 in debt (Wall Street Journal); at the standard 4.29% interest rate and 10-year repayment period, that adds up to $8,124 in interest paid for a grand total of $43,123 (Federal Student Aid Repayment Calculator). The standard student loan repayment plan at that figure is $359/month over 10 years. If you instead invested $359/month for 10 years, then let it sit for an additional 20 years, at the S&P 500 historical return rate your investment *would be worth* $246,542. Add in your loss-of-income while attending school (average $36,000), and your total loss of wealth is a staggering $282,542!

With tuition fees climbing at twice the rate of inflation (and textbooks at triple the rate), you risk falling behind instead of getting ahead. College debt can put you in a financial hole that makes it difficult or impossible to purchase a home, buy a car, or even take days off work!

The good news is YOU CAN escape the college debt trap, YOU CAN set yourself up for career and financial success, and YOU CAN live the lifestyle you’ve always wanted. All you need is the right plan.
THIS IS YOUR PLAN TO ELIMINATE COLLEGE DEBT – AND TAKE THE FIRST STEP TO SECURING LIFELONG FINANCIAL SUCCESS!

College costs are skyrocketing, but paying for college isn’t rocket science. In fact, this guide walks you through the exact steps you need to graduate debt-free. Use it along with the Student Budget Tool to create your personalized plan to pay for college. The Student Budget Tool is an interactive spreadsheet that:

- Maps out all your college expenses and income
- Identifies future cash flow shortages so you’re not caught off-guard by big bills
- Tracks payments as you make them and automatically updates your budget so you always know how much money you have and how you need to spend it
- Automatically calculates your True Total Cost of College
- Helps you set goals, get money, and save money

The Student Budget Tool is a living document you’ll use throughout your college career to make sure your money is on track and you’re on the path to escaping college debt-free!

*** Starting today ***

YOU WILL MAKE YOUR PLAN FOR A DEBT-FREE DEGREE!

Getting a late start? Already in debt? Graduating soon? No problem! Simply add your debt payments to the Student Budget Tool to get them paid off before they become problematic. If you missed scholarship and other deadlines, apply next year. In the meantime, the Student Budget Tool will keep you on-track so you don’t accumulate more debt!
HOW TO USE THE STUDENT BUDGET TOOL

The Student Budget Tool is your plan to destroy student debt, and you’ll use it to complete the Take Action! components throughout this guide. Here’s how to use it:

——— If you use Google Drive...

1. Open the Student Budget Tool in Google Drive (CLICK HERE)
2. Click File > Make a Copy... to save it to your Google Drive

——— If you use Microsoft Excel...

1. Open the Student Budget Tool in Google Drive (CLICK HERE)
2. Click File > Download As... > Microsoft Excel and save a copy to your computer

——— If you use Open Office Calc...

1. Open the Student Budget Tool in Google Drive (CLICK HERE)
2. Click File > Download As... > OpenDocument Format and save a copy to your computer

Once you’ve saved the Student Budget Tool, simply follow the steps in this guide to make your personalized plan to destroy student debt!
**GOALS**

**STEP 1: SET YOUR GOALS**

*Setting the right goals early is the first step toward a debt-free degree*

You need to know what you want before you can formulate a plan to pay for it, so we’ll start by identifying three critical goals, in this order:

- **Lifestyle**
- **Career**
- **College**

Notice how the college degree you choose will dictate your career options, which in turn will affect your lifestyle.

What if you don’t know what you want? That’s OK. You should still complete the goal-setting exercise as a brainstorming session. Actively thinking about where you want to go in life can spark inspiration to help you answer tough questions. Plus, your goals are flexible – you’re free to change your mind later!

If you’re already nearing your graduation date, you can adjust your goals to reflect the career and lifestyle you want; or, skip to **STEP 2: KNOW YOUR EXPENSES** to map out a plan to pay off student debt.
Follow the outlined steps to eliminate debt before it accrues and put yourself on the path to lifelong financial security and the success and happiness it will afford you.

Set **SMART** goals now to enjoy your dream lifestyle later

Your goals should follow the **SMART** formula:

Let’s compare poor goals to **SMART** goals:

<table>
<thead>
<tr>
<th></th>
<th>Poor Goals</th>
<th>SMART Goals</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Specific</em></td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><em>Measurable</em></td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><em>Attainable</em></td>
<td>Yes, but not defined</td>
<td>Yes</td>
</tr>
<tr>
<td><em>Realistic</em></td>
<td>Yes, but not defined</td>
<td>Yes</td>
</tr>
<tr>
<td><em>Time-bound</em></td>
<td>No</td>
<td>Yes, a deadline has been given</td>
</tr>
</tbody>
</table>

Check out [Creating SMART Goals](#) by UMass Dartmouth for additional goal-setting tips.
LIFESTYLE GOALS

What type of life do you want? Consider:

- Where you want to live
- What kind of house you want
- What kind of car you want
- Whether you will get married or have children
- How much you want to work
- Where you want to work
- What you will do for leisure
- Where you will vacation, and how often
- How you will spend your weekdays and weekends

Example lifestyle SMART goals include:

- I want to work 40 hours per week
- I want 6 weeks of annual vacation
- I want to own a 3,000 sq. ft. beachfront home with a pool in Key West
- I want to get married and have 3 children by age 35
- I want to spend one hour each day doing activities with my children
- I want to work for a charity that improves lives for the disadvantaged within two years of graduation
CAREER GOALS

Your career goals should revolve around:

- What type of job you want
- Where you want to work
- Who you want to work with
- Your position or role
- Benefits and vacation time
- Income you want to earn

Example career SMART goals include:

- I want to become a senior architect with a major firm by age 28
- I want to own a successful architectural firm by age 35
- I want to earn $180,000 per year by age 40

EVALUATE YOUR CAREER GOALS

Once you’re certain you’ve set strong career goals, evaluate whether those goals will help you achieve your dream lifestyle. If not, you’ll need to edit your career goals until they do.

For example, if you’ve always wanted to be a teacher and you have a lifestyle goal to own a million-dollar home by age 35, chances are your teacher’s salary is going to fall short of allowing you to do that.

You’ll either need to come up with a way to supplement your income; or, you might need to consider a different career path to satisfy your lifestyle goals. You can also edit your lifestyle goals if they’re not realistically aligned with your career goals.

One of the best ways to determine whether your career goals fit your lifestyle expectations is to reach out to people who have the job you want. Tell them you’re considering a career in their field and ask questions about their income range, working hours and overall lifestyle. Job shadowing is another good way to gain insight into the kind of lifestyle a given career can afford – and it could also lead to internship and employment opportunities.
Learn more about career options, salaries, and occupation profiles from these resources

Monster Career Research Tools
Careers.org Career Research
Career One Stop (sponsored by the U.S. Dept. of Labor)
Quint Career Research Checklist
National Career Development Association
Princeton University Library | Vault Career Library
The Career Project

COLLEGE GOALS

Your lifestyle and career goals are set; now, it’s time to lay the foundation for achieving both by defining your college goals.

**You should have two primary college goals:**

- TO OBTAIN THE DEGREE YOU NEED TO MEET YOUR CAREER GOALS
- TO GRADUATE DEBT-FREE
  (or, if you’re near graduation, to quickly pay off student debt)

**You should also have secondary college goals. They might include:**

- To earn a high GPA and participate in activities that will make you a more attractive candidate for employment
- Networking with professors and professional peers to help achieve career goals post-graduation
- Taking time to enjoy the college experience without sacrificing grades

TAKE ACTION! SET YOUR GOALS

Open the Student Budget Tool and click on the “SET GOALS” tab.
List your lifestyle, career, and college goals, and make sure each passes the SMART test.
The most critical step to destroying student debt is to know how much college will actually cost – and how you’re going to pay for it. You have to create a budget and anticipate expenses, then make a plan to cover those expenses. If you’re already in debt, you need to formulate a plan to pay your debt off quickly.

Since your costs will be unique, you need to conduct your own research to determine your True Total Cost of College. That’s where the Student Budget Tool comes in!

The Student Budget Tool makes it easy to make your college budget. It automatically performs all the calculations for you so you can instantly:

- See your True Total Cost of College
- Know how much money you need to earn each month
- Identify future cash flow shortcomings

The Student Budget Tool does the hard work for you! It also lets you track your payments so you always know at-a-glance what bills are coming up and how much cash you have free.

The Student Budget Tool is much more than a simple budget tracking tool – it is your personalized plan for controlling what you will spend so you can destroy student debt!

In this step, you’re going to research all your college expenses, then input each in the Student Budget Tool. We’ll start by listing common college expenses along with money-saving tips for each. For reference, the Student Budget Tool includes a sample that’s already filled out with estimates for each expense.
Understanding cash flow is an important part of determining your expenses so you can set your budget. Your cash flow is the amount of money you have on-hand, and it’s critical to anticipate expenses to ensure your cash flow is adequate.

**Example:** Let’s say most of your bills are month-to-month but once each year you have to make a $1,000 payment (a periodic expense). You need to plan to save to make that payment by earmarking money in your savings – money that’s not technically part of your cash flow.

To make that $1,000 payment, you would need to save $84 per month. Thus, each month $84 should be added to your budget so you’re not caught short on cash when the payment is due. The Student Budget Tool performs these calculations for you automatically!

**Determine Your Expenses**

To calculate your True Total Cost of College, you need to tally up all your expenses. It’s important to anticipate expenses and prepare for unexpected emergencies. You also have to account for year-to-year increases and decreases in known expenses.

---

*Let’s take a closer look at some of the most common college expenses.*

**Common College Expenses**

**School**

**Tuition and Fees**

Tuition is typically based on a set rate per credit hour. However, you can’t go by credit hours alone since some classes have additional fees for things like lab use and special activities. In addition, you might have enrollment fees or non-academic fees like gym membership that aren’t included in the credit hour rate.

**Here’s how to determine your tuition:**

- Contact your college’s admissions or financial aid office directly and ask for a line item fee schedule based on your selected degree and specific courses, both required and elective. Be sure to ask about any anticipated annual increases (for example, College Board data shows public four-year school tuition fees increased by an average of 2.9% between 2015 and 2016).
• Many colleges have online calculators to help you determine your tuition. Search Google for “[COLLEGE NAME] TUITION CALCULATOR” or visit your college’s website directly to see if one is available. You should still double-check your figures directly with the school.

• Use an online tool like College Abacus to compare tuition fees between schools. Again, be sure to double-check figures with your school.

**WHAT TO EXPECT**

Here are average annual tuition rates according to College Board:

→ Public two-year in-district: $3,435
→ Public four-year in-state: $9,410
→ Public four-year out-of-state: $23,893
→ Private four-year nonprofit: $32,405

Keep in mind that college tuition fees can vary greatly between different schools, which is why you have to determine your exact costs rather than rely on averages.

**SAVE ON TUITION AND FEES**

**TAKE REQUIRED COURSES AT A COMMUNITY COLLEGE**

Community colleges represent excellent money-saving opportunities, including:

- Cheaper tuition
- The ability to stay at home and avoid cost-of-living expenses that can wreck student budgets
- Night classes scheduled to allow you to work a part- or full-time day job and stockpile funds
- Credits that are transferrable to larger universities
- On-site student-work programs

Earn your associate’s degree at a two-year college, then switch to a four-year school for your bachelor’s. Before picking a community college, make sure all the credits you earn will transfer to your next school (check with your admissions officer or advisor to learn more).

You can also take summer classes at a community college. Doing so offers education diversity.
and lets you get ahead on credit hours while you’re living at home. You can even take part-time classes one or two nights per week and work a full-time day job to put more money away for the upcoming school year.

Some community colleges even offer four-year degrees, especially if they’re extension branches of larger universities.

College Board estimates the total average annual expenses for students attending community college to be $16,325, but that’s if you live on your own. Stay home, and you’ll save $7,705 in room and board. That comes to $8,620 per year.

So, to simplify:

- **Average cost of public four-year college, first two years on-campus:**
  $23,410 \times 2 = $46,820

- **Average cost of community college, two years (living with parents):**
  $8,620 \times 2 = $17,240

- **Two-year savings by attending community college:**
  $46,820 - $17,240 = $29,580

- **You’ll also save $10,868 by not taking student loans,**
  for a total savings of $40,448
TAKE ONLINE CLASSES

Online classes:
  • Can be taken over summer break to reduce your fees
  • Are often cheaper because they do not require class time
  • Can be taken according to your schedule
  • Allow you to meet educational goals while living at home
  • Can easily eliminate thousands of dollars in cost-of-living expenses and free time to earn more money

NEGOTIATE FEES

Some tuition fees are negotiable, such as athletic fees for the use of the campus gym and arts fees for access to school concerts. Ask your school’s administrative office for an itemized breakdown of your tuition fees, identify any unnecessary fees, and ask your school to remove all non-required fees.
TEXTBOOKS

The average four-year college student will spend nearly $5,000 on textbooks over the course of earning their degree, and that’s five grand many fail to account for. When you first enroll it’s easy to become overwhelmed by all the radical changes in your life, so you might want to buy textbooks from the campus bookstore your first semester or two. Once you get the hang of things, you can save significant money by buying your textbooks online.

SAVE ON TEXTBOOKS

Use Direct Textbook to save up to 90% on textbooks; plus, get lower prices on used textbooks, rental textbooks, ebooks, access codes, and alternative editions like international and teacher’s editions.

RENTING VERSUS BUYING

Should you rent or buy textbooks? There are several factors to consider:

- Rentals tend to have cheaper sticker prices, but they also incur shipping fees and leave you liable for damages
- If you damage a rental textbook, you will have to pay the full price of a new textbook
- Buying might be more expensive upfront, but you can typically sell textbooks for cash at the end of the semester
- Do you want to reference a given textbook throughout your professional career?

If you don’t want to keep your textbooks and you’re not prone to damaging or losing books, you should compare the true net cost of renting versus buying (and reselling) for each book on your list to get textbooks at the lowest prices.

For example, a textbook might be sold for $100 and rent for $75. If you can resell the textbook for $50 at the end of the semester, the total net cost is $50 – less than the cost of the rental.

WHAT ABOUT EBOOKS?

Ebooks are typically sold in rental, or access, periods. You pay for access to the ebook during your semester. Ebooks offer the convenience of being able to read from many different devices plus advanced capabilities like in-text searching and digital bookmarking. Like rentals, ebooks tend to have cheaper upfront costs but cannot be resold; buying textbooks and selling them later can yield a lower net cost.
**ALTERNATIVE EDITIONS**

In addition to buying used textbooks, you can purchase alternative editions like teacher’s editions, past editions with nearly-identical content, and international editions.

International editions are textbooks sold in foreign markets. They typically have identical content, but are often paper-bound. Since they cost less overseas, companies can buy and resell them online at steep discounts over their traditionally-published counterparts.

**AVOID EXPENSIVE “CUSTOM” EDITIONS**

Some required textbooks can prove impossible to find outside the campus bookstore; that’s because bookstores work with publishers to print custom textbook versions with unique ISBNs. These “custom” editions typically have identical content to existing textbooks, albeit with a few minor (and often unimportant) changes. Custom editions exist because they attempt to force students to buy new textbooks.

If your course requires a custom textbook and you can’t find the title and ISBN of the original textbook it was adapted from, check your professor’s university web page, website, or syllabus (search “PROFESSOR NAME + syllabus” or “PROFESSOR NAME + COURSE NAME”). Professors often list the books they use on these materials. If you still can’t find the textbook you need, contact your professor directly. Many are happy to help and will tell you the title or ISBN of the original textbook so you can search for the lowest prices on Direct Textbook.

**DON’T SELL TEXTBOOKS TO THE CAMPUS BOOKSTORE – GET MORE MONEY ONLINE**

At the end of the semester, don’t sell your used textbooks back to the bookstore – they’ll pay only a fraction of their true market values. Instead, sell your used textbooks for more on Direct Textbook.

This strategy of buying textbooks at the lowest prices and selling them at the highest prices has the potential to completely offset your textbook investment and eliminate $5,000 or more in debt.
SCHOOL SUPPLIES

Remember that school supplies – computers, tablets, notebooks, and pens – can rival the cost of tuition. Fortunately, there are easy money-saving strategies you can employ to slash school supply costs and free more money to pay for tuition, room, board, and entertainment.

COMPUTERS, TABLETS, AND OTHER DEVICES

Like textbooks, one of the best strategies for saving on electronics is to buy them used. In addition, only buy what you need – if you don’t need a gamer laptop with 32GB RAM, don’t splurge for it: unless you’re a graphic design or CAD student, you can probably get everything you need in a laptop or tablet for under $500 new, and even cheaper used.

DESK SUPPLIES

Notebooks, binders, pens, highlighters, staplers, and more – none of them are very expensive alone, but the costs can add up. Take advantage of back-to-school sales and discount stores to minimize expenses. Dollar stores are great, but you can find many items for less than a buck during back-to-school sales. You can probably get all the desk supplies you need for less than $50 per semester. Need a backpack? You can get a good one online for under $20.

HOUSING

RENT

Where will you live while you attend school? The answer will have a significant impact on your overall budget. Options include:

DORM LIVING

Dorm living might not be the most convenient option, but it’s probably cheaper than paying for your own place – which might not even be an option, since many schools require you to live in the dorm during your freshman year. In addition to your room (which you’ll share with roommates), dorm fees typically include three meals per day and do not incur utility fees.

My College Guide estimates average annual dorm costs for public schools to be $8,887; private schools, $10,089. These figures include both dorm housing and meals (room and board), but you’ll want to check with your school to see if meal plans are independent from dorm fees. If you do have to buy an additional meal plan, see if there are cheaper options available. For example, you might opt to only eat two meals per day on-campus, then cook your own breakfast or dinner.
RENTING AN APARTMENT OR HOUSE

Renting your own apartment or house is the most expensive option if you go it alone, but you can significantly reduce expenses by sharing rent, utilities, and even grocery bills with roommates.

Rental fees vary by location, but you can expect to spend between $500 and $1,500 per month to rent an apartment or house. According to Apartment Lists’s Rentonomics, median apartment rental rates in the U.S. are $1,180/month for a one-bedroom apartment and $1,330/month for a two-bedroom apartment, though you can typically find cheaper options near campus. Before you rent, be sure to properly vet any potential property or landlord. It’s a good idea to consult parents or others you trust who have experience in this area to avoid potential problems.

Tips for saving:

- Try to negotiate a lower rent or add utilities to the agreement; at the very least, try to negotiate a no-rent-increase guarantee
- Get roommates and split the bills
- Conduct your research and compare multiple properties before deciding
- Consider proximity to campus, shopping, and transportation: living too far away might ultimately prove more expensive than paying a higher rent near campus
- Rent a place that provides appliances to avoid paying for them: refrigerator, range, washer and dryer (or access to a washer and dryer)
- Be sure responsibilities are clearly defined: who is responsible for lawn maintenance and repair costs?
- Can you sublet your apartment or house? If so, you can take on roommates and collect directly from them to reduce your housing expenses. You might also consider subletting your space if you head home for the summer months

Don’t forget that rentals typically require a down payment equal to your first month’s rent, plus you’ll need to pay for renter’s insurance to protect your belongings. You can get renter’s insurance for less than $20 per month.

LIVING AT HOME

Staying home with your parents likely isn’t the most attractive option for your social life, but it’s almost certainly your cheapest option. If you live near campus or plan on attending a community college, living at home will save thousands of dollars. Plus, you might get extra perks like home-cooked meals and help with laundry.

Though living at home is typically cheaper than other options, keep in mind it can increase transportation and parking costs.
**UTILITIES**

In addition to your rent, you’ll have to pay utility bills each month. Utilities include:

- Water
- Electric
- Natural gas/propane (for heating, unless you have electric heat)

Contact your utility providers directly for help estimating monthly costs; they have historical records by address and can give you an idea of what to expect based on what past tenants have paid. You can probably expect to pay between $100 and $200 per month for utilities.

**GARBAGE DISPOSAL**

If you rent, you’ll likely have to pay for trash removal. Some municipalities include a refuse fee on monthly utility bills, others require you to purchase special tags or bags, and still others require a combination thereof. If you live in an apartment complex, you might have to pay a dumpster fee; though chances are use of the dumpster is included with your rent.

**INTERNET, CABLE TV, AND STREAMING SERVICES**

Internet, cable TV, and streaming services like Netflix can add up to big bucks. Here’s what you can expect:

- Internet access: $70
- Cable TV: $70
- Landline telephone: $20
- Netflix: $10

Saving tips:

- Skip any services you don’t want or need; many people are dropping cable TV in favor of a streaming service, and few people need landlines these days
- Compare multiple service providers and do not automatically assume bundled packages are cheaper; in fact, a Mintel study found that triple-play subscribers pay more than those who choose multiple providers
- Negotiate fees directly with providers. Some might offer student discounts; others might be willing to lower your rates to avoid losing your business to competitors
MOBILE PHONE AND SERVICE

BUY USED DEVICES

Used smartphones and other devices can be purchased online. If you want the newest, latest and greatest smartphones, keep an eye out for carrier credits and subsidies that can help offset the cost of a new iPhone or Galaxy S series. Generally-speaking, you can expect to pay around $70 per month for mobile phone service.

SKIP CARRIER INSURANCE

Skip carrier insurance and purchase a cheaper plan through Worth Ave. Group or a similar company.

CONSIDER ALTERNATIVE PHONE OPTIONS

Several wireless carriers offer discounts through academic institutions, which can significantly reduce your monthly bills. You can also choose an alternative no contract carrier like Republic Wireless or Ting, which uses WiFi to reduce your fees.

FURNITURE AND DÉCOR

Furniture is another expense to consider when living in a dorm or renting an apartment or house. You’ll also need cooking and cleaning supplies, as well as dinnerware. Save money on furniture by:

- Buying used furniture
- Sharing furniture expenses with roommates
- Shopping thrift stores, garage sales, and Craigslist for the lowest prices
- Get hand-me-downs from friends and family members

Outfitting an apartment can cost anywhere from $500 to $2,000 or more.

SUPPLIES

Finally, you need to consider the ongoing cost of living supplies: soap, laundry detergent (or trips to the laundry mat), paper towels, garbage bags, cleaners, and other items all cost money.

TAKE ACTION! COMPARE HOUSING OPTIONS

Housing has an enormous impact on your True Total Cost of College, which is why it’s critical to conduct your research and make intelligent housing decisions. Fortunately, housing is an expense you have some control over. Be sure to fully investigate all your options and determine a total cost for each before you make your decision.
TRANSPORTATION

TRANSPIT FEES
If you plan to take the bus to-and-from campus, transit fees can add up. Look for busing options that offer student discounts and see if your college partners with local transit authorities to offer free busing for students. The University of Oregon and The Ohio State University, for example, both offer free bus passes for students. Keep in mind you still might have to pay for busing to non-campus stops.

CAR PAYMENT
Plan on driving your own car? If you have a loan, you’ll need to continue making payments while in school – an expensive option, given the !
Save money on car payments by purchasing a cheaper car, in cash if possible.
If you need to get a loan:
- Shop around – different lenders offer different rates, so you’ll want to get the best deal
- Ask about student discounts, including discounts for good GPAs
- You might be able to reduce your interest rate and build credit by having a parent co-sign
- Ask your college’s financial aid office or consult its website to see if it publishes a recommended lenders list for students

Resist the temptation to purchase the flashiest car you can afford; instead, be sensible, conduct your research (Edmunds and Kelley Blue Book are good choices), and choose a lower-priced, reliable car to avoid costly repairs. You can buy your dream car after you destroy your student debt!

AUTO INSURANCE
If you have a car, you’ll need auto insurance. Several factors affect how much you will pay for auto insurance, but in general you can expect to pay anywhere from $800 to $1,500 per year or more.

Save money on auto insurance by:
- Staying on your parents’ insurance policy while in college
- Asking for student discounts, particularly for a good GPA
- Getting quotes from multiple insurers to find the best rate

Learn more about saving on auto insurance from The Trusted Choice and The Simple Dollar.
PARKING

Be sure to investigate whether you’ll incur parking fees on-campus or near your residence, as well as parking passes or metered fees for places you’ll frequent (downtown shopping districts, for example). Parking might cost around $50 per month.

MAINTENANCE

Your car will need routine maintenance like oil changes and car washes, plus the inevitable (and unexpected) repair, which we’ll cover in the Budget Busters section. For most vehicles, you might budget between $25 and $50 per month for routine maintenance.

SAVING ON TRANSPORTATION

College transportation can get expensive fast, but you can save money by:
- Leaving your car at home and taking advantage of free college busing
- Living close enough to walk to campus
- Carpooling with other students
- Seeking student discounts on everything from loans and insurance to parking permits and bus passes

BUDGET BUSTERS

Most of the expenses we’ve listed to-date are static; that is to say, you know exactly how much each is going to cost. In this section, we’ll cover Budget Busters: expenses that are tougher to predict. If you do not account for them, Budget Busters can become problematic. The good news is you can use the Student Budget Tool to control these expenses!

THE ENVELOPE SYSTEM

The best way to deal with Budget Busters is to use the envelope system espoused by money management guru Dave Ramsey. Here’s how it works:

1. You create an envelope for each item on your Budget Buster list. On the front of each envelope, write the name of the expense and its monthly budget.
2. When you get paid, you place cash in each envelope.
3. When you need to pay for any given Budget Buster, you take the money from its designated envelope. If there is not enough in the envelope, you need to save more before you make the purchase. You cannot borrow money from one envelope to fill another.
Here's an example. Let's say you budget $100 per month for entertainment. If you get paid weekly, you'll put $25 per week into your “Entertainment” envelope. When you want to go to a concert, you check your envelope to see if you have enough saved up to afford it.

Another example: You budget $100 per month for clothing. Each month you place $100 in the “Clothing” envelope, but you don’t shop for clothing every month. After three months, you have saved up $300 you can spend on clothing.

The envelope system works by ensuring you have cash to cover your expenses and by limiting how much you spend so you don’t go over-budget.

Now let’s take a closer look at some common Budget Busters and ways you can save on each.

### FOOD

If you’re not careful, groceries, cafeterias, and restaurants can quickly bust your budget – but that doesn’t mean you have to settle for Ramen noodles and macaroni and cheese.

Check out these resources for tips on eating well for less than $100 per month:

- Mavis Butterfield’s One Hundred Dollars A Month
- Saving the Crumbs

Try to keep your food budget around $150 or less per month. You can save on food expenses by:

- Eating at home or in the campus cafeteria if meals are free
- Choosing a lower-cost meal plan and substituting with home-cooked meals
- Fixing meals at home with friends and sharing the costs
- Shopping at discount stores such as Aldi’s
- Avoiding dining out and buying beverages such as coffee – brew it at home instead
- Clipping coupons relentlessly, take advantage of price matches, and always shop for the best deals
- Asking for student discounts
Seeing if you are eligible for SNAP (Supplemental Nutrition Assistance Program), formerly known as “food stamps.” Most students are not, but if you work at least 20 hours per week or are in a state- or federal-funded work-study program, you might qualify. Other factors, including having an eligible child or attending school through a government program, can also make you eligible for SNAP. Learn more about SNAP eligibility for college students and how to apply here.

**CLOTHING**
You don’t have to bust your budget to stay in style! Budgeting around $100 per month should be enough, especially if you:

- Shop at second-hand and discount stores
- Take advantage of online and student discounts
- Ask for clothing for your birthday and holidays so you don’t have to spend as much on yourself

**ENTERTAINMENT**
Movies, books, clubs, concerts, and other forms of entertainment aren’t cheap, but you can still enjoy yourself without breaking the bank. A reasonable entertainment budget for most students is around $100 per month. Limit entertainment expenses by:

- Planning free activities with your friends – go to the park, stay in instead of going out, or take advantage of free student events
- Splitting entertainment costs like movie rentals and video game purchases with roommates
- Prioritizing entertainment – stay in one weekend so you can afford a better event the next weekend

If you plan on taking vacation (like going away for Spring Break), you should also create a separate envelope for your vacation fund.
**GAS**

We didn’t include gasoline in transportation because it can quickly bust your budget, particularly if fluctuating gas prices are high.

Save on gas by:

- Limiting your vehicle travel
- Carpooling
- Sharing the cost of fill-ups with friends
- Taking advantage of gas savings cards. Some grocery stores, for example, offer significant gas savings based on how much you spend in-store

How much you need to budget for gas depends on how much you’ll travel, but you should be in good shape if you keep it to $200 per month.

**PERSONAL UPKEEP**

You need to take care of yourself while you’re in college, which means you’ll need personal maintenance products and services like haircuts, pedicures, manicures, and makeup. Depending on your needs, you might budget between $50 and $100 per month for personal upkeep. If your school has a cosmetology program, you might be able to get some of these services free.

**TAKE ADVANTAGE OF STUDENT DISCOUNTS**

If you want to destroy student debt, living lean is the name of the game. Many stores offer student discounts that can add up to significant savings. Always ask if student discounts are offered, even if they’re not published; and check out our list of stores that offer student discounts in the Resources section at the end of this guide.
OTHER EXPENSES

Here are some other common expenses you might not have considered.

HEALTH INSURANCE

Health insurance can prevent an unexpected illness or injury from derailing your budget and sending you spiraling into debt. Here’s how to save on health insurance:

- If you’re under 26, you can stay on your parent’s health insurance plan
- See if your school has a discounted student health insurance plan – many do
- Apply for government-subsidized health care or Medicaid

This Bankrate article presents additional options for affording health insurance while in college. Keep in mind that even with health insurance you might have to pay a deductible or co-pay when you receive medical care. In addition, your plan might not cover dental or vision.

How much should you budget for health insurance? It ultimately depends on your plan, but most students can get coverage for around $60 per month.

CREDIT CARDS

If you have credit card bills, you’ll want to formulate a plan to pay them off by the time you finish school. This isn’t to say credit cards are bad; in fact, they can help fix temporary cash flow problems. The best strategies to save money on credit cards are to:

- Get a student-friendly credit card with a low interest rate
- Ask for a rate reduction to help pay it off faster
- Pay off the balance at the end of each month to avoid paying interest

If you already have credit card debt, use this credit card payoff calculator to figure your monthly payments. A reasonable budget for credit card payments might be $100 per month. Find student-friendly credit cards on Nerd Wallet and The Simple Dollar.

GYM MEMBERSHIP

If you don’t have free use of the campus gym you might need to pay for gym membership – which might be around $80 per month. Save on gym membership by:

- Comparing gyms in your area and identifying low-cost options
- Seeking out free workout options like community basketball courts and running paths
Seeing if your gym offers student discounts or has a partnership with your school

Seeing if your gym offers a “buddy pack” discount if you join with a group

Keeping an eye out for enrollment fee-free days to save money when you join

Asking if your gym offers income-based discounts and free memberships

EMERGENCY/REPAIR FUND

Emergencies and repairs can be the biggest Budget Busters of all. Prepare for the unexpected by budgeting at least $100 per month for your emergency fund.

If you have an emergency that exceeds the amount in your emergency fund, you can use your credit card to cover it as long as you create a plan to pay it off.

To save on repairs, see if you have a friend or relative willing to complete them for cheap, trade, or even free. If you do have to get something professionally-repaired, be sure to get quotes from multiple providers to get the best rate.

STUDENT LOANS/OTHER DEBT

What if you already have student loans? You can begin formulating a plan now to pay them off. A couple of scenarios are:

• You took out student loans as a freshman but have since committed to avoiding additional loans. Since student loan repayments are deferred until after graduation, you can input your total student loan repayment amount in your graduation month in the Student Budget Tool. The tool will automatically calculate how much you need to set back each month to pay off your student loans in one lump sum after graduation

• You have decided to defer payments until after graduation, or you have already graduated. You can still use the Student Budget Tool to create a plan to pay off your student loans. Simply input the total amount in your desired payoff month, and the tool will automatically calculate how much you need to pay each month to be debt-free by your target date. This is a great strategy for paying off your student loans early!

BANK ACCOUNT

You’ll need a bank account to save money and, ideally, online access to pay your bills. Be sure to compare banks to keep costs low. The best option for college students is a no-fee bank account with no minimum balance.

Nerd Wallet offers a helpful tool for finding the best student bank accounts in your area, but be sure to conduct your own research before you choose.
TAKE ACTION! LEARN TO LIVE LEAN

Learning to live lean is a big part of graduating debt-free. Avoid overspending on items, especially those that are unnecessary. Use the “Living Lean” tab in the Student Budget Tool to brainstorm ways you can save money.

CASH FLOW

As mentioned, monitoring your cash flow and ensuring you have enough to cover unexpected expenses is critical to destroying student debt. Fortunately, the Student Budget Tool makes it easy to predict cash flow and anticipate upcoming expenses. It even shows you exactly how much you need to earn each month to cover those expenses!

TAKE ACTION! LIST YOUR EXPENSES

1. List all of your expenses in the Student Budget Tool. Take the time to conduct your research and be as accurate as possible. If you need guidance, you can consult the “Completed Example” tab – just keep in mind your actual expenses might be more or less than the listed examples.

2. Anticipate any increase in expenses over subsequent years, and keep in mind the average student takes 5.5 years to earn a bachelor’s degree. If you plan on attending school longer than 4 years, you need to account for the additional expenses.

Once you’ve listed your expenses, the Student Budget Tool will automatically calculate your True Total Cost of College. In the next section, you’ll identify income sources to reduce the overall financial burden of attending school and plan to destroy student debt!
College isn’t cheap, but you don’t have to pay in-full, either. A combination of financial aid, work opportunities, and intelligent budgeting will help you destroy student debt. In this step, you’ll work to offset the expenses you set in STEP 2. Your goal is to find enough reliable income to match or exceed that figure. If you can do that, you can escape college debt-free!

TRADITIONAL FINANCIAL AID

The first place to look for money is traditional financial aid. Here’s how to get it.

FAFSA

Complete the Free Application for Student Federal Aid (FAFSA) to apply for financial aid. The FAFSA is a needs analysis that dictates your Expected Family Contribution (EFC). Created by the U.S. Dept. of Education, the FAFSA is used by colleges and other organizations to determine the amount of financial aid you’ll receive.

CSS PROFILE

Going to a CSS school? There are around 200 private schools and state colleges that require you to fill out the College Scholarship Service Profile, in addition to the FAFSA. A CSS Profile is more invasive – it asks for a lot of financial information the FAFSA doesn’t, and it counts more toward your Expected Family Contribution (EFC) – but that’s because many private schools award larger sums. The average grant awarded by Middlebury College, for example, is $36,000 (Bankrate), and you must complete a CSS Profile to be eligible.

GRANTS

Grants are free money. Unlike student loans, they never need repaid. Unlike many scholarships, they don’t come packed with stipulations (there are a few rules and restrictions, but you don’t have to maintain a perfect GPA or be an All-American athlete to get them). The Federal Pell Grant is one of the best-known grants available for low-income families, but did you know if you receive a Federal Pell Grant you also quality for an SEOG (Supplemental Educational Opportunity Grant)?

TAKE ACTION! APPLY FOR FINANCIAL AID

Use the “Get Money” tab in the Student Budget Tool to list traditional financial aid opportunities and track your application progress.
SCHOLARSHIPS

Scholarships are well-covered elsewhere, but be sure to keep an eye out for scholarships you have a good chance of receiving; that is to say, scholarships for which you are a prime candidate. So, while you should definitely apply for those full-ride scholarships awarded by your target schools, you should also apply for lesser-known scholarships that might be more relevant to you.

WHERE TO FIND LESSER-KNOWN SCHOLARSHIPS

After you’ve scoured all the college scholarship listing websites, check out these resources to find scholarships you might stand a good chance of winning.

- **Community foundations** – see if your hometown or local school foundation offers scholarships
- **Small non-profit organizations** – smaller, cause-centric non-profits often offer scholarships for related fields of study
- **Online search** – search for your field of study plus “scholarship” to uncover hidden gems; for example, “water conservation scholarship”
- **Ask businesses** – many corporations offer scholarships; some will even pay your full tuition in return for a post-graduation work commitment
- **Family foundations** – many family foundations support specific causes and award scholarships to students in relevant fields of study
- **Civic groups** – Kiwanis, Rotary, the Fraternal Order of Eagles and the like all offer scholarships, often on both national and local levels. Seek out lesser-known civic groups, such as your local downtown association, for more opportunities
- **Your employer** – some employers offer scholarship funds for their employees; you should also see if your parents’ employers offer scholarships for their employees’ children
- **Your religious affiliation** – religious organizations offer scholarships, even for non-religious studies
- **Books** – books such as “The Ultimate Scholarship Book” and “Peterson’s Scholarships, Grants, and Prizes” include scholarship listings, though they might be competition-heavy
- **Weird scholarships** – some companies and organizations offer rather unique scholarships, some are well-publicized, others are not; search for weird scholarship opportunities to see if you can come up with a creative idea to help you win. Examples include Jif’s “Most Creative Sandwich” scholarship and the “Wear Duck Tape to Prom” scholarship
Finally, don’t forget about Direct Textbook’s own scholarships: each year we offer our Scholarship Essay Contest, Photo Essay Scholarship Contest, and Haiku Scholarship Contest.

Do your research, be proactive, and seek relevant scholarships other students have overlooked. It’s a great way to find – and win – more money for college.

TAKE ACTION! APPLY FOR SCHOLARSHIPS
Use the “Get Money” tab in the Student Budget Tool to list scholarship opportunities and track your application progress.
**OTHER FINANCIAL AID**

You might be able to get other types of financial aid that can reduce your Total Cost of College. They include:

- Graduation gifts
- Tax benefits
- Investment funds, such as 529 plans
- Asset elimination

Discuss what might be available to you with your parents, who might wish to consult a financial adviser or accountant to determine what additional strategies are available to pay for college.

**COLLEGE CREDITS FOR WORK EXPERIENCE**

Did you know you can get college credits for your work experience? This is especially true if you’ve spent several years in the same field or have specialized training, including military training.

There are three ways work experience can be used to help you reduce the cost of college.

- **Course competency exams** – These are administered by the colleges themselves and allow you to test out of specific courses. You can study for course competency exams by reviewing syllabi and buying or renting course textbooks.

- **Work experience credit** – Many colleges offer credit for work experience. You’ll have to prove you have professional experience applying the material taught by each course, but this strategy can save thousands of dollars in tuition and supplies.

- **Life/work experience degrees** – Some colleges offer full degrees based on work experience. You’ll have to make a compelling case to get your degree without taking any classes. Keep an eye out for scams – any college that offers life/work experience degrees should be accredited by a [U.S. Dept. of Education-approved regional accrediting agency](#).

Talk to your advisor about getting credits for your work experience.
**EARN INCOME**

Now you know how much income you’ll need to earn by working each month in order to graduate debt-free. There are two primary ways to earn income: work-study programs and getting a traditional job.

**NOTE:** The income you receive via work-study programs does not affect your financial aid eligibility; however, if you earn more than $6,400 per year via traditional employment, your financial aid will decrease by 50 percent of anything you make over $6,400.

---

Example: if you make $7,000, you will lose $300 in financial aid.

\[
\frac{(\text{TOTAL INCOME} - 6,400)}{2} = \text{LOSS IN FINANCIAL AID}
\]

\[
\frac{7,000 - 6,400}{2} = 600
\]

\[
600/2 = $300
\]

For this reason, we recommend taking advantage of work-study programs before seeking traditional employment; if your work-study program doesn’t cover the remainder of your monthly budget, you can work a traditional job part-time and stay under the $6,400 threshold, thus maximizing your dollars-per-hour.

**TAXES**

Keep in mind your income is taxable; thus, you should only record your income after taxes in the Student Budget Tool. Some scholarship and grant funds could be taxable as well, particularly if they’re used for non-tuition items like room and board.

Always keep track of your expenses and maintain records so you can claim tax deductions. Most students will also be eligible for the standard deduction; if you’re not a dependent, you can also claim a personal exemption.

Get tax tips from College Board (http://collegeboard.com/prod_downloads/highered/res/cc_tips/TaxTips05.pdf) and consult a professional accountant for more information.
WORK-STUDY PROGRAMS

Work-study programs are among the most underutilized forms of financial aid available. Students fear they’ll be trapped into jobs they hate or working arrangements that clash with their class and study schedules. However, work study programs are created to facilitate, not hinder, college, and are generally more lenient than traditional employment.

If you participate in an on-campus work-study program you can also reduce commuting time, thereby saving transportation costs and freeing study time.

Alternative work-study programs can help cover the cost of college. Some companies, for example, will pay for your entire education in return for a post-graduation work commitment. Another type of program has students attend college for a semester, then work for a semester, until school is completed – fully funded by the employer.

HOW TO FIND WORK-STUDY PROGRAMS

- Check with your college’s financial aid office to find out what work-study programs they offer; schools offer both on-campus programs and partnerships with off-site work opportunities
- Ask your professors; establishing good relationships with your professors and getting good grades can open doors to unique opportunities for work-study now and your career later
- Search online for work-study programs in your chosen field; for example, “biology + work-study program”
- Research companies you would like to work for and ask about work-study programs; if they do not offer such programs, propose one
- Employer-sponsored work-study programs do not have to align with your career goals (though it can help). For example, Seattle-based Dick’s Drive-In pays up to $25,000 for employee education; and Starbucks offers a College Achievement Plan that pays for college at Arizona State University, whether you want to spend 30 years working for Starbucks or not
- See our list of companies that offer work-study and tuition assistance programs in the Resources section at the end of this guide

TAKE ACTION! APPLY FOR WORK-STUDY PROGRAMS
Use the “Get Money” tab in the Student Budget Tool to list work-study opportunities and track your application progress.
GET A JOB

If you’re not doing a work-study program, or if you are and there’s still a gap between your total income and your expenses, you’ll need to get a traditional job to destroy student debt.

The best jobs:

→ Work around your class schedule
→ Have relevance to your degree (to provide future opportunities)
→ Pay well enough to minimize your hours worked yet cover your monthly budget
→ Can sometimes be found by asking professors and advisors

HERE ARE SOME WAYS TO GENERATE INCOME WHILE ATTENDING COLLEGE:

- Find employment with local businesses; clothing retailers, grocery stores, mall kiosks, theaters, and restaurants often have evening shifts and weekend schedules that accommodate class and study time
- Tutor
- Provide a service: babysit, pet-sit, walk dogs, house sit, shovel snow, mow grass, wash windows, paint, do yard work, do laundry, clean homes, etc.
- Sublet your apartment
- Buy used items, like smartphones, then resell at higher prices. You can find used items at yard sales to sell to thrift stores or private Craigslist and Ebay buyers. For smartphones, video game consoles, tablets, and books, use Flipsy to find market values and sell at a profit
- Repair computers, smartphones, and other devices
- Be a teacher’s assistant or grade papers for professors or departments. Simply ask professors if they hire TAs or graders and how you can apply
- Be a research assistant. Ask your adviser who you need to speak with to apply
- Take notes, edit/proofread papers, or otherwise provide non-tutoring student services
- Be a residential assistant. Some schools pay RAs, others do not; either way, you should get significantly reduced room and board fees
- Work online: you can offer freelance writing, programming, graphic design, social media management, or virtual assistant services and work around your own schedule. Try sites like Upwork and Fiverr to get started
- Start a blog, YouTube channel, or website that brings in money; note that starting a successful online business – or any formal business – can be extremely time-consuming and slow to profit
SUMMER CAN BE YOUR BIGGEST EARNING SEASON

Don’t forget summer jobs, either; if you’re not taking classes (or you’re taking a few classes online, according to your schedule), summer is your biggest earning season of the year. Moreover, some summer jobs can help you earn work experience you can apply toward college credit. Other opportunities might have career relevance and help you gain experience and contacts you’ll need in your professional career.

TAKE ACTION! APPLY FOR JOBS

Use the “Get Money” tab in the Student Budget Tool to list job opportunities and track your application progress.

TAKE ACTION! TALLY YOUR INCOME

Input all income sources from Financial Aid, grants, and scholarships on the “Monthly Budget” tab.

- The Student Budget Tool will automatically calculate the difference between your income and your True Total Cost of College. That figure represents how much you need to earn each month via work-study or direct-employment to graduate debt-free.

- Next, enter your projected monthly income from work-study and employment. The College Budget Tool will automatically calculate your monthly balance and project it for the duration of your college career.

- It will also identify any cash flow shortcomings; if they exist, the Student Budget Tool will show you exactly how much you need to either INCREASE INCOME or DECREASE EXPENSES to balance your budget and destroy student debt.

USING THE STUDENT BUDGET TOOL

You’ve now identified your expenses and income, but your job is far from done. The Student Budget Tool isn’t a one-time use tool, but a living document that automatically makes adjustments as-needed and serves as your central accounting and budgeting tool to ensure you’re on track to for a debt-free degree.

As you make payments on your expenses, delete them from the Student Budget Tool. The tool will automatically recalculate your monthly balance and cash flow to keep you on track with your goals.
REVIEW YOUR GOALS AND PROGRESS

If there’s one constant in life, it’s that things change. That means your education, career, financial, and lifestyle goals can change. Your major might change. Your income might change. Your financial aid might change. Any and all changes have the ability to impact your plan dramatically.

REVIEW YOUR GOALS AND PROGRESS ANNUALLY

For that reason, you must reevaluate and, where necessary, reset your goals and action plan on an annual basis. Every year, take time to:

- Gauge where you are in terms of meeting your goals; are you on-pace or behind schedule? Why? What specific steps do you need to take to get back on track?
- Determine whether your goals still align with your desires. Are they about making your life what you want it to be? Should any goals be scrapped, or new goals added?
- Identify new opportunities and resources that can help you achieve your goals
- Review income and expenses and make adjustments to your budget as-needed

It’s important to continually monitor your goals in order to consistently achieve them.

SCHEDULE WEEKLY AND MONTHLY FINANCIAL REVIEWS

In the beginning, you should also dedicate at least one hour each week to:

- Review your cash flow, income, expenses
- Make sure you’re adhering to your budget and make spending adjustments if necessary
- Project upcoming expenses or financial challenges and find their solutions

Soon you’ll get the hang of habitual reviews and can scale back to monthly reviews.

TAKE ACTION! REVIEW YOUR PLAN

Use the “Review” tab in the Student Budget Tool to schedule time to review your plan and ensure you’re on track to meet your goals.
MAKING A COMMITMENT AND GETTING HELP

Planning to pay for college is difficult, let alone planning to graduate without debt. Making and saving money requires dedication and hard work. Not everyone can graduate college debt-free – in fact, most do not. But if you’re truly committed to putting yourself on the path to financial success, there’s no better way than to earn a college degree without going broke.

If you’re struggling to figure out how to escape college debt-free, or how to afford college at all, it’s a good idea to consult with experienced experts who can help you properly position assets, apply for financial aid, balance your budget, and save for your future. You can start with these experts.

G.M. “George” Scott, Jr.
Seeds of Wealth Financial Group, LLC
803.781.3600
gscott@seedsofwealthfinancial.com
www.seedsofwealthfinancial.com

George Scott—a.k.a. The Financial Gardener—founded Seeds of Wealth Financial Group, LLC, in 2008 to specialize in college funding and planning. A financial services expert since 1971, George has co-hosted the radio show SuccessTalk and hosted his own shows, FYI Today and The Financial Gardener. He is a contributing writer to The State’s College Planning series, a public speaker and occasional television guest, and has participated in numerous financial workshops.

Reecy Aresty
Payless For College
561.451.0111
561.445.8109
www.paylessforcollege.com

Reecy Aresty, a respected college admissions and financial aid advisor and lecturer since 1977, has helped thousands of families protect their assets, increase their wealth, and at the same time reduce their taxes. He’s the author of “How to Pay for College without Going Broke” and Founder and President of Payless For College. He has also been featured in some of the country’s most respected publications including Money Magazine, US News and World Report, Consumer Digest, Bloomberg News, Scripps Howard, The Washington Post, and AOL.

Katie Ross
Education and Development Manager
American Consumer Credit Counseling
800.769.3571
www.consumercredit.com

Katie Ross joined ACCC’s management team in 2002 and is currently responsible for organizing and implementing high performance development initiatives designed to increase
consumer financial awareness. Ms. Ross’s main focus is to conceptualize the creative strategic programming for ACCC’s client base and national base to ensure a maximum level of educational programs that support and cultivate ACCC’s organization. Ms. Ross is certified by the Center for Financial Certifications as a Certified Personal Finance Counselor.

**Kassi Fetters**  
*Financial Planner*  
*Fetters Financial Services*  
[www.fettersfinancialservices.com](http://www.fettersfinancialservices.com)

Kassi Fetters is owner and founder of Fetters Financial Services. Specializing in financial planning and education counseling, Ms. Fetters guides clients toward living debt-free by creating a plan for the mid- and long-term. The goal at FFS is to teach clients how to use money and planning as tools to achieve their aspirations. Ms. Fetters also specializes in helping students cut tuition costs, figure out how much money they will need to earn a degree debt-free, and plan a degree path that leads to future success.

**Jodi Okun**  
*College Financial Aid Expert*  
*College Financial Aid Advisors*  
[http://collegefinancialaidadvisors.com/](http://collegefinancialaidadvisors.com/)

College Financial Aid Advisors (CFAA) was founded by Jodi Okun in 2008 to provide a one-on-one service for families who seek financial aid for their children’s higher education. Dubbed in Huffington Post as one of the “Top 30 Social Influencers in Personal Finance & Wealth,” Jodi is known for her smart insight on a range of 21st-century topics, including social media, entrepreneurship, and, especially, college financing. Her Twitter chat, #CollegeCash, receives an average of 10 million impressions a week.
COLLEGE PREP STRATEGIES

If you’re still in high school, take advantage of these strategies to dramatically reduce the cost of college.

GET GOOD GRADES

One of the best ways to pay for college is to present yourself as an excellent scholarship candidate. This process begins in high school (and some say middle school). Work to earn a high GPA, invest yourself in school and community projects and organizations, play sports or an instrument, if you have the aptitude, and study your way to a high score on standardized tests.

Preparation will help you win more than scholarships; many schools award “merit aid,” which is financial aid untied to financial need.

“Take the PSAT, ACT, and SAT. The PSAT will show your shortcomings so you can get books to prepare for the test. Just a few points on test scores can amount to thousands of dollars in merit aid,” says Scott.

TAKE CLASSES THAT OFFER COLLEGE CREDIT

More high schools than ever are offering college-level AP (Advanced Placement) classes that either count as college credit or serve as study courses for passing course competency exams. Some colleges are even training high school teachers to teach college-level courses or “lending” college professors to high schools for college-level courses.

In addition, many high schools and colleges offer “dual credit” for taking college courses while in high school. For example, a student could take a political science class at a local community college (during the school day) and be awarded both college credit and credit for a government class required to graduate high school.

The best part? High schools, not students, typically pay for these courses. If students and parents do have to pay, it’s a nominal fee compared to the cost of taking classes at college.

TAKE SUMMER AND ONLINE COURSES

You can take college courses during summer break, earning credits while in high school without the distraction of high school studies. You can also take online classes, during the summer or while attending high school, to get ahead on your education and reduce future expenses. Your high school might pay for these classes, even if you take them when it’s not in session.
VOLUNTEER AND NETWORK

Chances are, there a lot of local scholarships available (see the Scholarships section); one way to get your shoe in the door is to volunteer your time with the awarding organizations. Network with board members and be willing to lend a helping hand. These are the people who make scholarship decisions; impress them early, and you could be awarded thousands of dollars to help pay for your education.

START SAVING NOW

Know how much college will cost, create a budget, and start saving now. The sooner you start saving, the more money you’ll have later. If you can make $2,000 per month during the summer, it will take just two summers to cover the cost of your first year of community college, with money left over to go toward your second year. Work the summer between your freshman and sophomore years at college, and you’ll earn a two-year degree debt-free.
COLLEGE FINANCE ASSISTANCE EXPERTS

- American Consumer Credit Counseling
- Payless for College
- Seeds of Wealth Financial
- Fetters Financial Services
- College Financial Aid Advisors

FINANCIAL AID RESEARCH (SCHOLARSHIPS, GRANTS, WORK-STUDY)

- FastWeb
- College Board
- Scholarships.com
- ScholarshipMonkey
- FinAid
- Federal Pell Grants
- FAFSA
- CSS Profile
- Federal Work-Study Program
- Federal Student Aid Portal

Be sure to check merit scholarship programs, college-specific work-study programs and scholarships, as well as employer-sponsored work study programs (contact specific employers to inquire) for more opportunities.

STUDENT DISCOUNTS

- Business Insider – 34 discounts every student should use
- Best College Online – 100+ stores that give a student discount
- PuckerMob – 75 things you can score with your student ID
- Direct Textbook – save up to 90% on textbooks
- Flipsy – sell old textbooks, smartphones, tablets, video game consoles, and computers for cash
- Best no-contract cell phone plans

COMPANIES THAT OFFER WORK-STUDY AND/OR TUITION ASSISTANCE PROGRAMS

Note: This list isn’t comprehensive; conduct your own research and don’t be afraid to propose a work-study arrangement with companies that don’t have established programs.

- Raytheon
- Disney
- UPS
- Wells Fargo
- Verizon
COOL SUMMER JOB SEARCH RESOURCES

Want a unique summer job that also offers great pay? Check out these summer job search resources.

→ FastWeb – 30 Exciting Summer Jobs for College Students
→ Mountain Jobs
→ Lifeguarding Jobs
→ Kareeve
→ Resort Jobs
→ Summer Jobs
→ CoolWorks

HELPFUL APPS

Grocery IQ (Best Free College Grocery Sharing App)
Flipsy BookSeller (Best Free College Moneymaking App)
Around Campus (Best Free College Coupon App)
Direct Textbook (Best Free Cheap College Textbook App)